
What’s New in CreativeStudio™ Version 2.0.0 
 

Gammill is pleased to announce CreativeStudio™ Version 2.0.0 which is available at 
http://www.gammill.net/index.php?m=statler_downloads.  Username and Password is available 
on the Statler User group.  If you don’t have access to the Statler User Group contact 
support at 1-866-830-3738. 
 
CreativeStudio™ upgrade instructions: 

 If you do not have an older version of CreativeStudio™ installed go to 
“CreativeStudio™ fresh install instructions” below. 

 Navigate to the Gammill downloads site and using the username and password 
provided, download the CSsetup2.0.zip file. 

 As you would with any compressed (zipped) file, extract the 2 files in this download. 
 Transfer these 2 files (CSDeployment.msi, CSsetup2.0.exe) to your jump drive for 

moving to your Statler and disconnected computers. It is these 2 files which are required 
to install CS V2.0 on a Statler which has been running any earlier version of CS. 

 CreativeStudio™ 2.0.0 is a full version, so the previous version must be removed first.  
 Navigate to C: > Control Panel > Add or Remove Programs. Select and remove the 

installed copy of CreativeStudio. 
 When prompted to restart your computer, select no or restart later. 
 Insert your jump drive with the 2 files downloaded and extracted above. 
 Select and double-click on the CSsetup2.0.exe file name to begin the install. 
 Carefully read and follow all on-screen prompts, including entering your machine Mod 

when so prompted. 
 Reboot you computer 
 Start CreativeStudio™ and notice the splash screen now states Version 2.0.0 
 Under the Tools menu item, select “Calibrate Stitcher” 
 This is not common: If you have a specialized controller setup, go to “Tools”, “Controller 

Definition”, “File”, “Restore Previous”, “Save and Close”.  Restart Creative Studio and 
now your specialized setup is restored. 

 You are now ready to run CreativeStudio™, Happy Quilting  
 

CreativeStudio™ fresh install instructions: 
 If you have never had CreativeStudio™  installed on your computer you need to contact 

Gammill at 1-800-659-8224, ext 213 to purchase a version 2.0.0 CD. 
 You need to install from a CD at least once because the support files needed are very 

large and their installation is complex. 
 The CD will auto install the many needed support files for you. 

 
Stand Alone installation instructions: 

 You must first install CreativeStudio™ from a CD, it doesn’t matter which version you 
have.  Follow the directions closely and reboot your computer when done. 

 Now move to the CreativeStudio™  upgrade instructions above 
 

If you experience problems installing the software please contact: 
Statler Stitcher Support 1-866-830-3738 or email: Support@StatlerStitcher.com  

 



This release of CreativeStudio™ has many new features and it contains fixes that have 
been brought to our attention since the release of V1.2.0.  This release is thoroughly 
tested; if you find a problem please report it to Support@statlerstitcher.com.  Also we 
have added many new enhancements to improve the user’s experience.  These 
enhancements came from quilter’s like you.  If you have ideas for enhancements 
please send them to enhancements@statlerstitcher.com.  We at Statler Stitcher have 
always been very focused on what our quilters would like to see in future versions of the 
software.  Thank you. 
 
New Features  

 Save patterns for future reuse. 
  Easily export your pattern(s) to our new CSQ pattern format. This allows patterns 
or a group of patterns to be copied from one quilt group, or project, to another.   
Also patterns in CS can be exported to DXF. 
  To Use: Select the pattern(s) you wish to Export. Right click the selected pattern(s), 
Select “Export Pattern”, and then either “To CSQ” or “To DXF”.  The CSQ format is 
preferable since it maintains the pattern’s true arcs. (Note if there are encrypted 
patterns in your quilt group, then export to DXF will not be an option, also export to 
CSQ will save as a CSQX, which can only be opened on your controller.) 

 
 Change Sewing Order and direction 
  You now have the ability to set/change sewing order of patterns in a quilt group.   
During sewing the 'NEXT' indicates which pattern will sew after the 'START' pattern. 
In Set Sew Order mode there are arrows at the end of patterns to show the sewing 
direction.  The order and direction of the patterns can now be observed and 
changed. The set sew order box and the direction arrow are color coded to eliminate 
confusion caused by overlapping patterns. 
  To Use: From the top menu, select “Draw”, then “Set Sew Order” or “F8”.  The 
numbered box shows the pattern sewing order (note: zero is the first pattern).  The 
box is located at the start of the pattern, and there is a sewing direction arrow 
located at the end of that pattern. The box and the arrow are color coded to match; 
this is to help straighten sewing order on stacked patterns.  To change the sewing 
order, click the sew order boxes in the order you want them to sew (Note the 
selected boxes become clear and their arrows navy blue).  You do not need to select 
all the patterns in the quilt group only the patterns you want to sew first.  To commit 
your changes press “F8”, to cancel your changes press “Escape”. 

 
 Drawing Tools 
  All the functions that in the past you could only draw by moving the head, can now 
draw using the mouse.  These new Draw tools will greatly enhance your creativity! 
  The “Draw Trim” tool will help you precisely remove a little piece of a pattern.  The 
“Draw Boundary” tool can create a boundary for placing patterns, very helpful for 
filling the space between un-sewn patterns.   
  We added four new sewable drawing tools.  “Draw P2P Line”, allow you to draw 
with a sewable multi-pointed line.  New “Draw P2P Pattern”, allow you to draw with a 
sewable P2P pattern.  The “Draw Arc” places a sewable three-point arc, and the 



“Draw Curve” places a curve will go thru all the points clicked.  All become patterns 
that can be resized and added to existing patterns. 
    To Use:  All the drawing tools have a similar procedure, here we will walk you thru 
making a trim.  In the “Draw” menu select “Draw Trim” or ALT + T.  Notice the cursor 
changes to a crosshair, and the status bar reads “Draw a Trim”.  Every left click will 
place a trim point, keep clicking points till you have covered your desired pattern 
area, then right click to close.  All draw modes finish when you right click, then stay 
active to allow you to quickly do some more drawing.  To exit all draw modes press 
escape. Note: All the new CAD drawing modes can optionally snap to Grid or 
Endpoint. 
 

 
 Divide Pattern 
  Allows you to break a pattern into many separate parts or just in half. You can use 
the new pieces to make new patterns.  You can change a block pattern into a P2P, 
or a P2P into a corner pattern.  Combined with the drawing, sewing order, and 
pattern reuse features CreativeStudio™ is now a powerful tool for modifying 
patterns. Divided patterns keep their sewing order. 
  To Use:  Right click a single pattern, in that menu select “Divide Pattern”.  Pink 
node points will show at the junction of all the arcs and lines, when the cursor 
crosses a node it will turn to a crosshair, left click to divide the pattern at that node.  
Dividing a pattern turns one pattern into two patterns; you can further divide as 
desired. 
 
 Snap Tools 
  The new Snap Grid (G) will snap a pattern's endpoint to the grid intersections.  This 
is very useful for making a pattern into a repeatable pattern. 
  The new Snap Endpoint (E) will snap two pattern end points together.  This allows 
a repeating border to follow irregular piecing, but stay connected. The snap point is 
shown with a translucent pink circle.  A warning beep plays if you try to snap below 
the minimum allowable pattern size. 
  To Use: In a drawing mode or EndPoint Pattern Anchor mode you can mouse click 
the “G” or the “E” at the bottom of the screen, but it is easier to click “G” or “E” on the 
keyboard.  To turn off the snap mode click the “G” or “E” again. 

 
 Pattern Anchor Changes 
  The new End Point Pattern Anchor allows patterns to be moved by their endpoints.  
When you combine this with the grid or endpoint snap, you now have a method for 
connecting patterns, or for changing a crooked pattern into a repeatable pattern. 
  The new Centering Pattern Anchor allows patterns to be sized while keeping the 
center unchanged.  This greatly speeds up increasing or decreasing a pattern’s 
margin. 
  Edge Pattern Anchor will maintain the opposite edge.  In all pattern anchor modes 
the cursor hides when the selection handle is picked, and the Anchors are 
translucent to aid pattern placement. 



  To Use: From the menu select Draw, Pattern Anchor, then either Edge, Center, or 
EndPoint.  The keyboard shortcut keys are Edge(F9), Center(F10), and 
EndPoint(F11).  Highlight a pattern and you will see the handles change, Edge 
anchors have a blue outline, Center have a orange outline, and EndPoint have a 
blue outline, but there are only two anchors at the start and end.  Just mouse down 
and move to resize a pattern. In EndPoint mode you can optionally press “G” or “E”. 

 
 
 

 View Crosshair 
New "View Crosshair" shows your current needle position on the quilt, with a large 
full screen crosshair.  This is useful to find where your needle is in relation to your 
patterns, also useful to quickly check the quilting boundaries. 
  To Use:  Select the “View” menu item, then “View Crosshair”, the needle position is 
now shown on the drawing surface as a large crosshair. 

 
 Relocate Pattern / Project 
  New relocate pattern is used to adjust a pattern(s) location on the quilt.  This can 
reuse patterns, or shift a pattern slightly to compensate for shrinkage 
  To Use:  Right click the pattern(s) that you wish to move, select “Relocate”, “Shift 
Pattern”.  Now carefully position the needle where you want the pattern(s) to start 
and click “Yes”. 
  New relocate project, adjusts the origin so that the selected pattern is properly 
aligned, and therefore the entire quilt is properly aligned. Relocate Project Origin in 
an E2E will ask for the four corners. (If you have already rolled your quilt use the 
registration pins when prompted for the Upper corners). 
  To Use: Right click the pattern that you wish to relocate the origin to, select 
“Relocate”, “Relocate Project Origin”.  Now carefully position the needle over the 
sewn pattern’s start and click “Yes”.  This is a good way to recover a project where 
the origin has been set improperly.  With Relocate Project it is possible to sew 
another quilter’s project in its entirety. 

 
 Right Click Menu Improvements 
  New in Circular Array, if you click the word "Number of Copies" then the degrees 
are calculated, and the number of copies is reduced by one to compensate for the 
original pattern.  New in Circular Array if you click "at Degrees" then the Number of 
copies is calculated.  The degrees are adjusted as needed. These new calculations 
change the Circular Array degree calculations to negative (to assist clockwise 
sewing). 
  To Use: Right click your pattern(s) then hover over “Circular Array”, enter the total 
desired number of patterns, then click the label “Number of Copies”, the total will be 
reduced by one, and the degrees calculated to make a complete clockwise circle.  If 
you know the degrees enter that value and click “At Degrees”, the number of copies 
is calculated.  Note: To quickly make a continuous wreath use endpoint pattern 
anchor with end point snap turned on, and drag the end point of every pattern so 
that it snaps to start of the next pattern. 



  New in "Rotate 90 Degrees" now allows you to set the degrees of rotation.  This 
now rotates every click; this allows you to rotate a pattern several times. 
  To Use: Right click the pattern(s) then hover over  “Rotate 90 degrees” then 
change the value in the text box to (ex:)11.23, and hover over “Degrees”.  Notice the 
menu item now states “Rotate 11.23 degrees”, click this to rotate the pattern(s).  
This rotation is retained until it is changed by the user. 
  New Rubber stamp shift patterns to the right and up, and allows multiple clicks to 
make many copies. 
  To Use: Right click the pattern(s) and select “Rubber Stamp” as many times as 
desired.  The sewing order of the patterns is left to right. 
  New Reverse Start & End will change the direction a pattern will sew.  You can use 
this feature to keep sewing continuous, and to build up your own patterns. 
  To Use: Use Set Sew Order (F8) to check the sewing direction of the patterns and 
determine which patterns need to be reversed.  Right click the pattern and click 
“Reverse Start/End”, to confirm that the pattern changed press F8. 

 
 Stand Alone Mode 
New Stand Alone mode allows running CreativeStudio™ on another computer 
without Stitcher or a security key.  It allows encrypted patterns to open by asking for 
the encrypted number when it first starts up.  In Stand Alone you can use all the 
CAD tools, Divide, Reverse, Group All and Repeat Patterns.  These tools allow you 
to preview patterns, and build up your own specialized patterns. 
  To Use:  To install CreativeStudio™  on a computer that is not connected to a 
Stitcher and does not have a security key, you MUST install from a CD. This CD can 
be an earlier version.  After installing from a CD you can run the latest 
“CreativeStudio™ VX.X.exe” to upgrade to the standalone version.  When you start 
CreativeStudio™ you will get a message asking if you wish to run in Stand Alone 
mode, select “Yes”. 

 
 Accurate Selection of Stacked Patterns 
New Hit testing patterns is now much more accurate, this solves the problem of 
picking a pattern that has been stacked deeply. To Use: hold Alt and the click 
pattern, this selection mode is much slower than when you just click a pattern, so 
only use Alt + click when you really need it. 

 
 Improvements for Hand Ties 
  We now optionally will stop for a bobbin pull up at NoSew/Trim points if Tie Offs are 
disabled (and bobbin pull-up is enabled).  Also similar, another new feature, "Stop at 
Jump Stitch" is set on configuration page.   Both of these are for the quilter who 
wants the quilting to stop instead of dragging thread, they can then do a hand tie, or 
clip the drag threads. 
  To Use:  Go to “Tools”, “Technical Support”, “Controller Definition” and check “Stop 
at Jump Stitch” (OR uncheck “Tieoffs” and check “Bobbin Stitch”).  Now when the 
Stitcher comes to a jump stitch it will stop and let you manage the thread. 

 
 General Improvements 



 >Greatly sped up sewing and restart calculations on Trimmed patterns, by over 180 
times!  The time to calculate and start sewing is now nearly the same whether you 
have a trim or not. 
>Improved interlocking pattern support in Repeat patterns and E2E. 
>No-sew frames now supported, this places patterns with the margin that the 
designer place with a no sew outer frame. 
>Added more support of patterns with no-sew lines.  Now no sew lines are valid at 
the beginning and the end of a pattern, even multiple segment no sews are now 
valid. 
>Grid now covers the entire CAD screen. Gridline location is constant and is based 
off the origin.  This greatly helps all the new drawing tools.  Sometimes when you 
zoom the grid will disappear, the solution is to View All, then to zoom in and the grid 
will stay. 
>Designer pause logic improved, it is now much faster, and more consistently 
accurate. 
>Encrypted patterns now preview with a light blue background, this reminds the 
quilter which patterns are encrypted. 
>Zero margin is now acceptable; we used to recommend you put in a slight margin 
to assist the Pattern to Boundary process. 
>Fixed E2E concatenating hook up error that was in 1.2.0 
>Smoothed sewing on polyline patterns, well drawn polyline patterns can now sew 
as nearly as smoothly as a pattern drawn with arcs.  We still recommend quilters use 
patterns that are designed using arcs. 
>Support for nested P2P is a small change that has a big impact.  In the past we 
required P2P patterns to have a start and stop that was the widest point, now we 
allow an inset start and or end. 
>E2E & Repeat Patterns now show the pattern's rotation.  This is useful for 
recreating this exact pattern layout in another quilt group. 
>Stop in P2P Line and Pattern now makes a jump stitch.  Pressing stop used to exit 
the P2P functions, but we decided Shift + Exit does this, and there was a need to 
quickly create multiple series of disconnected P2P. 
>New we changed the sound for a point, TB, warning, and startup to be more 
informative. 
> Added a new DEF value to control length of 'trimmed' section that will be skipped, 
this allows you to set when a small section is skipped. 
>Stop the splash screen when the Stitcher is done loading.  Yes… we killed the 
mouse. 


